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Getting Started –  
Introducing AIA Contract Documents
Online Service

What is AIA Contract Documents? 

AIA Contract Documents is an online document automation service that allows you 
to	manage	your	project	data	and	generate	contract	documents.	You	can	access	
your	projects	and	documents	anytime	and	from	anywhere	using	your	favorite	
browser	(Internet	Explorer,	Firefox,	Chrome	or	Safari)	for	the	PC	or	the	Mac.	

The	service	provides	more	than	200	construction	contracts	and	forms	that	can	
easily	be	edited,	shared	for	review,	and	finalized.	Four	tabs	organize	main	page	of	
the	online	service;	the	Home	tab	includes	your	most	recently	accessed	projects	and	
documents;	the	Projects	tab	provides	quick	access	to	all	your	projects	and	related	
contracts	and	forms;	the	Templates	Library	tab	stores	all	of	the	standard	AIA	
Contracts	and	forms	available	for	editing;	and	the	Contacts	tab	saves	all	firms	and	
representatives	from	past	projects.

System requirements
Basic	requirements	for	AIA	Contract	Documents	include:

• A	high	speed	internet	connection.	The	minimum	connection	speed	for	the
AIA	Contract	Documents	online	service	is	512kbps;	connection	speeds
of	1000kbps	or	higher	are	recommended.

• The latest version of one of these web	browsers:	Internet Explorer, Safari,	
Chrome,	Firefox,	or	Edge)

• Adobe Acrobat Reader 9 or higher

• If	choosing	to	edit	offline,	a	current	version	of	Microsoft®	Office:	2010,	2013	
or	2016	

• The	AIA	Document	Mover	requires	Microsoft®	Net	Framework	version	4.5
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Transition from desktop version
If	you	are	moving	from	the	desktop	version	of	AIA	Contract	Documents	software	to	
the	online	version,	you	can	migrate	your	projects,	documents	and	contacts	for	use	
online.	The	instructions	below	will	assist	you	in	doing	so.	Please	note	that	it	is	not	
recommended	to	migrate	all	of	the	work	you	completed	in	the	desktop	software.	By	
default,	all	of	your	projects	are	stored	in	the	Documents	folder	of	the	computer	in	
which	the	desktop	software	is	loaded.	

Running the migration
• Click	“Get	the	AIA	Document	Mover	Utility”	in	the	“Getting	Started”	area	of	the	“Home”	tab
to	download	the	migration	utility	setup	file.	You	can	also	access	the	AIA	Document	Mover
Utility	here:	https://contractdocs.aia.org/migrationutilitydownload.html.	When	the
download	is	complete,	double-click the AIADocumentMover.msi	file	to	begin	the	installation.

• When	the	“Application	Install	Security	Warning”	displays,	click the Install button to run
the	installation.

• When	the	installation	is	complete,	you	will	be	prompted	to	sign	in.	Type	your	login	ID	and
password	in	the	spaces	provided	and	click the Sign In	button.

• After	a	successful	sign	in,	a	brief	migration	welcome	message	is	displayed	followed	by	the
Migration	Tool	screen.

– The	AIA	Document	Mover	allows	you	to	choose	which	projects	and	within	those
projects	which	documents	are	moved	to	the	online	service.

– The	AIA	recommends	moving	projects	one	at	a	time,	as	needed.

– Files	over	5MB	will	not	be	moved,	instead	can	be	imported.

– You	will	not	be	able	to	access	the	desktop	software	or	online	service	while	your
documents	are	being	moved.

• Once you have selected the items you want to migrate, click the Move Selected Data and
Documents button.	You	will	be	prompted	to	confirm	the	migration	of	the	selected	items.
Click	OK	to	continue	the	migration.

• When	the	migration	is	completed,	“Migration	Completed”	is	displayed.	Click	Go	to	Online
Account to log into your AIA Contract Documents online account, or click	Close to close
the	message	and	remain	in	the	Migration	Utility.

• To view the status or history of the migration, click	the							and							buttons	to	expand	or
close the Status or History panes.

Company settings
The	Company	Settings	panel	is	available	for	companies	with	multi-user	licenses	
only.	It	allows	the	Administrator	to	manage	users	and	groups,	configure	project	and	
group	permissions,	and	publish	global	clauses,	contacts,	and	custom	templates.	

https://contractdocs.aia.org/migrationutilitydownload.html
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The administrator role
Each	multi-user	license	must	have	at	least	one	designated	license	Administrator.	
The	Administrator	manages	access	to	the	multi-user	license,	configures	the	security	
features,	and	publishes	global	custom	templates,	clauses,	and	contacts.	For	your	
flexibility,	Administrators	can	be	designated	as	follows:
Administrator	–	Manages	users,	permissions,	and	publication	of	global	files	but	does	not	have	
access	to	other	software	functions	except	the	ability	to	renew	the	license.	This	account	does	not	
count	as	one	of	the	users	in	the	multi-user	license.

Administrator/User	–	Performs	the	same	duties	as	an	administrator	but	can	also	access	all	
software	functions.	This	account	counts	as	one	of	the	users	in	the	multi-user	license.

Users
Administrators manage users by inviting new 
users	to	join	the	license	or	restricting	access	
when necessary.

Adding users
• Click	the Add User button on the Users tab under
Company	Settings.	The	Add	User	dialog	appears.

You	may	designate	one	or	more	
of the existing users as a backup 
Administrator for times when the 
primary	Administrator
is	not	available.

QUICK TIP 1
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• Type	the	user’s	name	and	e-mail	address	in	the	spaces	provided.

• Click	OK.

• The	Add	User	dialog	is	displayed	with	the	message	“The	Email	has	been	sent	to	the	user
[user_name]	at	[e-mail	address].”

• Click	OK.

• The	user	is	added	to	the	users	list	with	a	status	of	“Invited,”	and	a	welcome	e-mail	is
sent with	instructions	for	accessing	AIA Contract Documents	and	logging	in.

Removing users

• Change	the	desired	user’s	status	from	Active	to	Inactive	on	the	dropdown	menu.

• Confirm	status	change	by	clicking	OK	when	prompted	with	the	message	“Are	you	sure	you
want	to	change	the	status	for	this	user	from	Active	to	Inactive?”.

• Click the Remove	link	located	to	the	right	of	the	user's	name.

• The	Remove	User	dialog	is	displayed	with	the	message	“Are	you	sure	you	want	to
Remove the	“[user_name]”	from	Multiseat	license?”.

• Click	OK to remove the user, or click	Cancel	to	exit	from	dialog	without	removing	the	user.

Groups
Administrators	can	create	groups	and	add	users	to	each	group.

Creating a user group

• On	the	Groups	tab,	click the Create	New	Group	button.	The	Create	New	Group	dialog
appears.

• Type	the	name	of	the	group	and	a	short	description	in	the	spaces	provided.

• Click	OK.

Adding users to a group

• On	the	Groups	tab,	click	the	group	name.	A	list	of	the	members	of	the	group	is	displayed.

• Click	the Edit	button.

• Click	the Add Members	from	Current	User	button	at	the	bottom	of	the	screen.	The	Add
Member	to	Group	dialog	is	displayed.

• Select the check	boxes	for	the	users	you	want	to	add	to	the	group.

• Click the OK	button.	The	users	are	added	to	the	members	list	for	the	group.
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Group permissions
In	AIA	Contract	Documents,	access	and	permissions	are	managed	at	the	group	level.	
There	are	two	levels	of	permissions	that	the	Administrator	can	designate:

Read - allows a user to view data for a 
project	but	not	change	it.

Read/Write	-	enables	all	functions.

If	a	user	is	in	groups	with	Read	and	Read/
Write	permissions	to	a	certain	project,	the	
more	restrictive	permissions	will	apply.

Adding groups to a project

• Under	Company	Settings,	click on the Projects	tab.

• Click the project	name.	A	list	of	the	groups	that	have	access	to	the	project	and	their	access
levels	is	displayed.

• Click the Edit	button.

• Click the Add	Group	button	at	the	bottom	of	the	screen.	The	Add	Groups	dialog	is	displayed.

• Select the check	boxes	for	the	groups	you	want	to	add	to	the	project,	and	select the level of
access	(Read	&	Write	or	Read)	from	the	drop-	down	menu.

• Click the OK	button.	The	groups	are	added	to	the	permissions	list	for	the	project.

• Click	the Save button to save your changes or Cancel	to	exit	without	saving	changes.

Adding groups to multiple projects (bulk permissions)
• With	the	Projects	tab	selected,	click on Bulk	Permissions.

• Select	a	group	and	the	appropriate	permissions	to	apply	to	your	project(s)	(Read	&	Write,
or	Read).

• Select	the	project(s)	you	would	like	to	apply	the	group	and	permissions	to.

• Click	Apply.

Removing a group from a project
• Select the check	box	for	the	desired	group	and	click	the Remove	Group	button.

• The	group	is	removed	from	the	project	(no	confirmation	message).

• Click	the Save button to save your changes, or click	Cancel	to	exit	without	saving	changes.

Deleting a project from company settings
• On	the	Projects	tab,	click	the Delete	link	for	the	project	you	want	to	delete.

• The	confirmation	message	“Are	you	sure	you	want	to	delete	the	project	“[project_name”?
Deleting	a	project	will	delete	all	the	folders	and	documents	contained	within	the	folders”
is	displayed.

• Click	OK	to	delete	the	project,	or	click	Cancel	to	exit	without	deleting	the	project.

By default, all users are added to
“Everyone” group, which has Read/
Write	permissions	for	all	projects.

QUICK TIP 2



Beginner’s Guide for AIA Contract Documents Online Service for Multi-Users 8

Global objects
For	companies	with	a	multi-user	license,	the	Administrator	can	publish	custom	
templates,	clauses,	and	contacts	so	they	are	available	to	all	company	users.

Publishing and unpublishing global custom templates

For	companies	with	multi-user licenses,	the	Administrator	can	publish	user-
specific	custom	templates	so	they	can	be	accessed	by	other	company	users	of	
AIA	Contract	Documents.

Once	a	custom	template	is	published	as	a	global	template,	only	the	Administrator	
may	edit	it	or	unpublish	it.	If	the	Administrator	chooses	to	unpublish	a	global	custom	
template,	it	will	once	again	be	made	local	to	the	user	who	created	it.

To publish a global custom template:

• Under	Company	Settings,	select the Custom	Templates	tab.

• For	the	desired	user-specific	template,	click	Publish.

• When	the	confirmation	message	“Are	you	sure	you	want	to	Publish	the	Template,
‘[template_name]’?”	is	displayed,	click	OK.	A	message	will	appear	stating	that	the
template	was	published.

  To unpublish a global custom template:

• On	the	Custom	Templates	tab,	click	Unpublish	for	the	desired	global	template.

• The	following	confirmation	message	is	displayed:		“Are	you	sure	you	want	to	un-publish
the	Template,	‘[template_name]’?	Note,	un-publishing	the	custom	template	will	cause
it	to	no	longer	be	available	to	the	system	users.	Any	Document	that	has	already	been
created	using	this	template	will	not	be	affected.”

• Click	OK	to	unpublish	the	template.

Publishing and unpublishing global clauses

For	companies	with	multi-user	licenses,	the	Administrator	can	publish	user-specific	
clauses	so	they	can	be	used	by	other	company	users	of	AIA	Contract	Documents.
Once	a	clause	is	published	as	a	global	clause,	only	the	Administrator	may	edit	it	or	
unpublish	it.	If	the	Administrator	chooses	to	unpublish	a	global	clause,	it	will	once	
again	be	made	local	to	the	user	who	created	it.

To publish a global clause:

• Under	Company	Settings,	select the Clauses	tab.

• Locate	the	desired	user-specific	clause	and	click	Publish.

• When	the	confirmation	message	“Are	you	sure	you	want	to	Publish	the	clause,
‘[clause_	name]’?”	is	displayed,	click	OK.	A	message	will	appear	stating	that	the	clause
was	published.



Beginner’s Guide for AIA Contract Documents Online Service for Multi-Users 9

  To unpublish a global clause:

• On the Clauses tab, click	Unpublish	for	the	desired	global	clause.

• The	following	confirmation	message	is	displayed:	“Are	you	sure	you	want	to	unpublish
the	Clause,	‘[clause_name]’?	Note,	Unpublishing	the	clause	will	cause	it	to	no	longer	be
available	to	the	system	users.	Any	Document	that	has	already	been	created	using	this
will	not	be	affected.”

• Click	OK	to	unpublish	the	clause.

Publishing and unpublishing global contacts

For	companies	with	multi-user licenses,	the	Administrator	can	publish	user-
specific	contacts	so	they	can	be	used	by	other	company	users	of	AIA	Contract	
Documents.
Once	a	contact	is	published	as	a	global	contact,	only	the	Administrator	may	edit	it	or	
unpublish	it.	If	the	Administrator	chooses	to	unpublish	a	global	contact,	it	will	once	
again	be	made	local	to	the	user	who	created	it.

To publish one or more global contact(s):

• Under	Company	Settings,	select the Contacts tab.

• Select	the	checkboxes	next	to	the	desired	contacts	and	click	Publish.

• When	the	confirmation	message	“Are	you	sure	you	want	to	Publish	the	selected
contact?”	is displayed,	click	OK.	A	message	will	appear	stating	that	the	contact
was	published.

To unpublish a global contact:

• On the Contacts tab, click	Unpublish	for	the	desired	global	contact.

• The	following	confirmation	message	is	displayed:		“Are	you	sure	you	want	to	unpublish
the	contact	for	firm,	‘[firm_name]’	?	Note,	Unpublishing	the	contact	will	cause	it	to	no
longer	be	available	to	system	users.	Any	Document	that	had	already	been	created	using
this	contact	will	not	be	affected.”

• Click	OK	to	unpublish	the	contact.

Create a project
The	AIA	Contract	Documents	online	service	is	project-centric,	which	means	
information	and	documents	are	created	and	stored	by	project.	

When	you	create	a	project,	you	will	need	to	provide	certain	project	information,	
such	as	the	project	description	and	party	names.	This	information	is	stored	and	
automatically	entered	into	all	the	documents	you	create	for	the	project.	

All	documents	and	imported	files	associated	with	a	project	are	listed	at	the	bottom	
of	the	Project	Data	screen.	You	can	create	subfolders	to	further	organize	your	project	
documents.
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Creating a project from the projects tab

If	you	know	the	project	data,	start	here.	You	can	add	data	later	and	use	the	sync	
feature as needed (please	refer	to	Quick	Tip	1	for	more	information	on	project	sync).

• Click	the Projects	tab.	A	list	of	your	projects	is	displayed.	The	first	project	in	the	list	is
automatically	selected	and	its	information	is	displayed	in	the	Project	Detail	window.

• Click the Create	a	New	Project	button	at	the	top	of	the	Projects	page.	The	Project	Detail
dialog	is	displayed	with	blank	spaces	into	which	you	can	enter	the	project	name	and
relevant	general	information.

• When	finished,	click the Save	Project	button.	A	message	will	appear	stating	that	the
project	was	saved	successfully.

Creating a project from a document

If	you	decide	to	create	a	document	rather	than	enter	project	data,	a	new	project	can	
be	created	using	data	provided	within	a	document.	Follow	these	steps	if	you	want	to	
select	the	first	document	in	a	project	and	create	the	project	at	the	same	time.

• Select the Template	Library	tab.

• In	the	Template	Library,	locate	the	desired	template	and	click its name	to	display	it	in	the
Online	Editor.

• From	the	Online	Editor	menu,	select Save to	save	the	template	to	your	project	folder	or
Save As	to	specify	a	different	project	or	folder.

• In the Save Document As dialog,	click the New	Project	button.

• In	the	Create	New	Project	dialog,	type the	project	name and click the Save	Project	link.

• Your	project	appears	in	the	list	of	projects.	Click OK	to	close	the	Save	Document	As	dialog.

• Click the Close	Window	link	to	close	the	Forms
Editor.

• Select the Projects	tab	to	display	the	Project
Detail	dialog.	If	the	Project	Detail	dialog	is
collapsed,	click the View	Project	Data	link	to
reveal	it.

• Enter the general project	information and
click Save	when	finished.

Revise an existing project
After	a	project	has	been	saved,	you	can	edit	
the	project	data	at	any	time.
• On	the	Projects	tab,	select	the	project.

• If	the	project	data	is	not	displayed,	click the
View	Project	Data	link	to	reveal	it.

• Click the Edit	Project	Data button to enable
changes,	if	necessary.

QUICK TIP 3

When	you	edit	project	data,	your	changes	will	
automatically be included in any new documents you 
create.	However,	documents	that	were	created	before	
you	made	your	changes	must	be	individually	updated	
using Project Sync	button	in	the	Online	Editor.	To	sync	
the	document	and	the	project,	do	one	of	the	following:

• Select Tools > Sync Project Data	from	the	menu.

• Click	the									button	in	the	toolbar.

• Click	the	Project Sync	button	in	the	sidebar.

Once	the	Project	Sync	window	opens,	you	can	sync	the	
document	and	project	data	by	either:

• Selecting	one	or	more	of	the	check	boxes	for	either
the	document	or	the	project	and	clicking	the	buttons
to	sync	the	selected	items.

• Clicking	the	Copy all to Project or Copy all to
Document	link	to	sync	all	items.
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• Make	changes	to	the	project	data	as	needed.	You	can	also	make	changes	to	the	project
team	and	distribution	list	and	add	or	remove	project	documents.

• When	finished,	click	the Save	Project	button.	A	message	will	appear	stating	that	the
project	was	saved	successfully.

Find the right document
AIA	Contract	Documents	are	organized	by	family	or	series	and	you	can	search,	sort,	
filter	and	compare	documents.	There	are	multiple	ways	to	find	the	documents	you	need. 

 Search: 
• Click the Templates	Library	to	reveal	a	listing	of	all	the	AIA	templates.	By	default,	the
documents	are	listed	alphabetically	by	series.

• Next	to	each	document	is	a	Preview	button	which	opens	a	sample	copy	of	the	standard
document.

• Click the More Actions	link	to	access	a	document	summary	and	instructions.

• Just	above	the	template	listing	is	the	Search	Templates	field	where	you	can	enter any
search	terms	you	wish.	Clicking	Go	will	perform	a	full-text	search	of	all	the	templates
that		contain	that	key	word	or	phrase.	Click	the Show	Advanced	Options button to narrow
your	search.

 Sort: 
• You	can	narrow	the	selection	of	documents	by	sorting	them	by	Series,	Family	and/or
Parties	Involved	on	the	left	hand	side	of	the	Templates	Library	tab.

• Clicking	a	link	on	the	left-hand	side	will	place	the	category	under	the	Selected	Templates
section	and	limit	your	search	to	the	specific	criteria.	You	can	remove	any	criteria	if	you
want	to	widen	the	search.

 Filter: 
• Click	on Series or Family or Parties	Involved	to	restrict	the	list	of	documents	shown.

• You	can	also	remove	the	filters	to	revise	the	list	of	documents	to	better	fit	your	needs.

 Compare: 
• Select 2-3 documents and click on the Side-by-Side	Comparison button if you are
deciding	among	several	agreements.	This	tool	is	for	use	on	agreements	only.	The	table
compares	the	documents,	showing	key	differences	between	them.	You	can	compare	up	to
3	documents	at	a	time.

“Help Me Select an AIA Template” tool:  

The	Help	Me	Select	an	AIA	Template	button	on	the	left-hand	side	of	your	screen	
is	another	way	to	help	you	find	the	document	that	you	need.
• You	will	be	asked	a	series	of	questions	designed	to	assist	you	in	narrowing	your	options	to
a	handful	of	documents	so	you	can	select	the	right	agreement	or	form	easily.
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• Make	selections	in	response	to	the	questions	that	are	asked.	Click the red Next	Question
button	to	advance.

• The	listing	of	AIA	templates	appearing	in	the	center	of	the	Templates	tab	will	adjust	based
on	your	responses.

Create an agreement
Draft	agreements	can	be	created	from	standard	or	custom	templates	and	can	be	
fully	edited	either	in	the	online	editor	or	offline	in	Microsoft	Word.	Offline	editing	
is recommended, especially for agreements.	You	can	set	your	default	settings	to	
Always	Offline	(Microsoft	Word)	by	clicking the My Settings	link	on	the	upper-right	
hand	side	of	your	screen	and	selecting	the	Document	tab.

To	create	a	draft	agreement	for	a	specific	project:
• Click the Projects	tab.

• Open	the	desired	project	in	the	Projects	list	on	the	left	side	of	the	screen	and,	if	applicable,
the	desired	subfolder	within	the	project.

• Click the Create Document	button.	The	Select	Template	dialog	is	displayed.

• Navigate	to	the	desired	template	(on	the	Standard,	Custom,	or	Favorite	Templates	sub-		
	 	 tab)	and	click the	template	name.

– The	templates	list	can	be	sorted	by	ID,	name,	series,	or	family	by	clicking the column
headers.	You	can	filter	the	documents	using	the	Filter	by	field.

• You	may	be	prompted	to	select	additional	information	about	your	document.	Answer	the
questions	and	click	OK.

• Click the name of the document to	open	in	the	online	editor.	Click	Edit	Offline	to	open	in
Microsoft	Word.

Working	offline

To	work	offline,	you’ll	need	the	Microsoft	Word	and	Excel	applications	on	your	
computer,	whether	it’s	a	PC	or	a	Mac.

To	download	an	agreement	or	form	that	you	have	saved	in	a	project:
• Go	to the Projects	tab.

• Select	a	project	from	the	Projects	list,	and	then	in	the	Documents	section	of	the	project
page	click	Create	Document.

• Click Edit	Offline	to	the	right	of	the	document	you	would	like	to	open	in	Microsoft	Word
or	Excel.

• Save	the	document	to	a	location	in	your	computer.

• Make	all	of	your	edits	offline.

Once	you	have	finished	revising	your	draft	document,	you	will	need	to	import	the	file	
into	the	online	service	to	generate	a	final	document.	To	upload	an	offline	document:
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• Go	to the Projects	tab.

• Choose the appropriate	project	from	the	Projects	list	and	click	the red Import	File button
within	the	project.

• Click	Choose	File,	select	the	file	you	wish	to	upload	and	click	Import.

• After	your	document	has	been	imported,	do	not	reopen	the	document.

• As	a	last	step,	click Finalize	to	the	right	of	the	imported	Word	document	to	generate	a	final.

Working online

The	Online	Editor	can	be	used	for	some	forms.	Click on the template	name	to	open	the	
document	in	the	Online	Editor.	The	text	of	the	document	appears	in	the	editing	window

Navigation	and	document	management	functions	appear	in	the	sidebar,	on	the	left.

The	most	commonly	used	editing	features	are	grouped	on	the	toolbars	immediately	
above	the	editing	window.

Create a form
Draft	forms	are	created	from	standard	templates.	Editing	of	forms	is	limited	to	the	
fill-points.

To	create	a	draft	form	for	a	specific	project:
• Click	the Projects	tab.

• Open the desired	project	in	the	Projects	list	on	the	left	side	of	the	screen	and,	if	applicable,
the	desired	subfolder	within	the	project.

• Click	the Create Document button.	The	Select	Template	dialog	is	displayed.

• Navigate	to	the	desired	template	(on	the	Standard	or	Favorite	Templates	sub-tab)	and	click
the template	name.	The	templates	list	can	be	sorted	by	ID,	name,	series,	or	family	by
clicking the column headers.	You	can	filter	the	documents	using	the	Filter	by	field.

• You	may	be	prompted	to	select	additional	information	about	your	document.	Answer	the
questions	and	click OK.

• The	draft	agreement	is	opened	in	the	Form	Editor	for	further	editing.

Customize a template
AIA	Contract	Documents	provides	you	with	the	ability	to	customize	agreement	
templates	with	your	standard	edits	and	then	use	those	customized	templates	as	
the	basis	for	your	draft	documents.	You	can	also	create	custom	templates	from	
draft	agreements,	and	share	them	with	other	users	in	your	company.	Standard	and	
custom	templates	can	also	be	added	to	your	list	of	favorites	for	easy	access	when	
creating	documents.
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Creating a custom template from a standard template 
• In	the	Templates	Library,	go	to	the	AIA	Templates	sub-tab	and	locate	the	template	you
want	to	customize.

• Right	click the More Actions link	and	select	Customize	Template	from	the	popup	menu.
The	Customize	as	Template	dialog	is	displayed.

• Type	a	new	name	for	the	template	or	leave	the	default	name	unchanged	and	click	OK.

• When	the	Important	Note	is	displayed,	read	the	message	and	click OK.

• The	template	is	displayed	in	the	Template	Editor.	You	can	make	any	edits	you	require.

• After	you	have	completed	your	edits,	select Save	to	save	the	template	on	the	Custom
Templates	tab	without	changing	its	name	or	Save As	to	save	it	with	a	new	name.

Creating a custom template from a draft 
• On	the	Projects	tab,	select	the	project containing the document you want to use as a
template.

• Locate the desired draft document, right	click the More Actions	link	from	the	popup	menu,
and select the Customize	as	Template	option.	The	Customize	as	Template	dialog	is
displayed.

• Type	a	name	for	the	new	template	or	leave	the	default	name	unchanged.	You	can	also
enter	a	note	in	the	Comments	box,	if	desired.

• Click	OK.	Your	draft	is	saved	as	a	template	on	the	Custom	Templates	sub-tab	in	the
Templates	Library.	When	you	create	a	Custom	Template	from	a	draft,	the	software	will
remove	project	data	from	the	fill-points.

Adding a custom template to your favorites 
• In	the	Templates	Library,	locate	the	desired	template	on	either	the	AIA	Templates	or
Custom	Templates	sub-tab.

• Right	click	the More Actions	link	and	select Add	to	Favorites	from	the	popup	menu.	The
Add	to	Favorites	dialog	is	displayed.

• Type	a	short,	relevant	name	for	the	template	as	you	want	it	to	appear	in	your	favorites	or
leave	the	default	name	unchanged.

• ClickOK.	The	template	is	listed	on	the	Favorite	Templates	sub-tab.

Importing	offline	documents	to	your	custom	templates	
• In	the	Templates	Library,	click	the Custom	Templates	sub-tab.

• Click	the red Import	Template	button.

• Click	Browse and select	the	desired	Microsoft	Word	document.

• Click	OK.
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Using the clause library
Clauses	are	one	or	more	paragraphs	of	text	that	you	can	create,	edit,	and	add	to	your	
online	editor	documents.	They	can	be	inserted	anywhere	in	draft	or	custom	templates	
for	any	of	your	projects,	and	they	can	be	used	multiple	times.

You	can	create	clauses	by	typing	the	text,	copying	text	from	a	draft,	or	pasting	text	
from	an	offline	document.	Clauses	do	not	support	special	formatting	or	images.

Clauses	can	be	organized	into	categories	to	make	them	easier	to	access.

Creating a clause 

You	can	add	a	clause	to	the	Clause	Library	as	follows:	
• In	the	Template	Library	tab,	select the Clause Library	sub-tab.

• Click the Create Clause	button.	The	Create	Clause	dialog	is	displayed.

• Type	a	meaningful	name	for	the	clause	in	the	Name	field.

• Type	or	paste	the	clause	text	in	the	Text	field.

• Select a category	for	the	clause	using	the	Category	drop-down	menu,	or	click	the Add
Category button and type	a	category	name	to	create	a	new	category.

• Use	the	Notes	field	to	enter	any	personal	notes	or	comments.

• Click	OK.	Your	clause	is	added	to	the	Clause	Library	sub-tab.

Creating a clause from a document

You	can	add	a	clause	to	the	Clause	Library	sub-tab	from	a	document	in	the	Online	
Editor as follows:	

• In the Online Editor, highlight the text you want to use from your document and select the
Add to Clause Library	button	from	the	left-hand	side.	You	can	also	select Tools > Add Clause 
from	the	toolbar.	The	Add	to	Clause	Library	dialog	is	displayed	with	the	text	you		 	
selected	in	the	Text	field.

• Type	a	meaningful	name	for	the	clause	in	the	Name	field.

• Select a category for	the	clause	using	the	Category	drop-down	menu,	or	click the Add
button and type	a	category	name	to	create	a	new	category.

• Use	the	Notes	field	to	enter	any	personal	notes	or	comments.

• Click	OK.	Your	clause	is	added	to	the	Clause	Library.

Inserting a clause

You	can	add	a	clause	from	the	Clause	Library	to	a	document	in	the	Online	Editor	as	
follows:

• Position	the	cursor	where	you	want	to	insert	the	text	in	your	document.

• Select the Insert Clause button or select Insert > Insert Clause	from	the	toolbar.	The
Insert	Clause	to	the	Document	dialog	is	displayed.

• Locate the clause you want to insert and click Insert.	The	text	is	inserted	in	your	document.
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Understanding the variance checker
AIA	Contract	Documents	allows	you	to	check	a	working	draft	against	the	original	
AIA	standard	template	and	note	any	differences.	Variance	checking	is	the	process	of	
comparing	your	edited	working	draft	(all	A,	B,	C,	and	E-series	documents,	as	well	as	
G601	and	G602)	against	the	original	AIA	standard	template	language.	

The	Variance	Checker	focuses	on	the	net	changes	between	your	draft	and	the	AIA	
standard	template.	If	you	have	used	Track	Changes	while	editing,	the	Variance	
Checker	first	accepts	all	the	changes	in	the	document	and	then	makes	a	word-by-
word	comparison	against	the	original	AIA	text.	

You	may	variance	check	a	working	draft	at	any	time.	The	Variance	Checker	is	run	
automatically	when	you	generate	a	final	document.	

Variance checking for a document can be started in either of two ways:
• From	the	Project	Details	area	by	clicking the Check	Variances	link	for	the	desired	document.

• From	the	within	the	document	in	the	Online	Editor	by	clicking the Check	Variances button
on	the	sidebar.

• The	Check	Variance	dialog	opens.

• Select the Variance	Markup	Format:

– Clean:	Additions	and	deletions	are	indicated
in	the	margin	where	they	occur.	The	details	of	the		
changes	are	appended	to	the	document	in	an		 	
Additions	and	Deletions	Report	(with	page		
references).	The	output	file	format	is	limited	to	PDF.

– Comparative: All changes are noted inline in the
document.	Additions	are	marked	with	underlining	
and	deletions	are	marked	with	strike-	throughs.

• Select the desired Output	File	Format:

– PDF:	The	checked	draft	is	generated	as	a	locked
(read-only)	PDF	file.

– Word:	The	document	is	generated	in	Word	in
DOCX	format	and	is	a	working	draft	that	you	can	
continue	to	edit.

• Click OK.

Finalize a document
Generating	a	final	document	accepts	all	
tracked	changes	and	adds	the	AIA	logo	and	
watermark.	The	final	document	will	always	
be	a	read-only	PDF,	which	can	be	viewed	
and	printed	in	Adobe	Acrobat	Reader®.	

The Variance Checker focuses on the net 
changes from the AIA master document. 
It	does	not	work	like	Track	Changes,	which	
shows all additions and deletions in real 
time	as	you	make	them.

QUICK TIP 4
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You	can	you	can	generate	a	final	version	of	a	working	draft	or	form	draft	document	
in	either	of	two	ways:
• From	the	Documents	area	for	the	project	or	a	subfolder,	choose the draft document you

would	like	to	finalize	and	click	to	the	right	of	the	document.

• From	the	within	the	document	in	the	Online	Editor	or	Form	Editor,	click the Generate	Final
button	on	the	sidebar.

• Select the Variance	Markup	Format (clean or
comparative).

• Select the Signature	Format	(written	or	digital).
See the Digital Signatures section for
generating	digital	signatures.

• For	the	Name	of	the	signing	authority,	confirm
the default name or provide	another	name
that	is	to	appear	on	the	D401	Certification	of
Document’s	Authenticity.	The	D401	should
be	signed	by	the	person	responsible	for	the
content of the edits made to the document
(typically	a	project	manager	or	principal).	The
person	who	implemented	the	edits	should
not	be	the		signatory	to	the	D401	unless	that
person	is	also	responsible	for	the	document
content.

Create/manage contacts
AIA Contract Documents manages all 
contacts from the Contacts tab, which 
provides	a	central	location	for	managing	
your	contacts.	

The	information	stored	for	contacts	you	create	is	not	project-specific.	When	creating	
a	project,	you	will	choose	project	team	members	from	this	list.

Your	list	of	contacts	can	be	sorted	by	category,	firm,	name,	telephone	number,	email	
address, or date by clicking	the column headers.	Contacts	must	first	be	created	
before	they	can	be	added	to	your	project	team.

To create a contact:
• On the Contacts tab, click the Create	New	Contact	button.	The	Create	Contact	dialog	is
displayed.

• Use	the	drop-down	lists	to	select the Category	into	which	the	new	contact	will	be	placed
(required)	and	the	firm’s	Legal Entity type.

• Type the name	of	the	contact’s	Firm	(required).

• Enter	as	many	other	details	for	the	firm	and	its	representative	as	possible.

• Click	OK to save the contact and close the dialog or Cancel	to	exit	without	saving	changes.

When	variance	checking	your	documents,	
all edits to the original AIA standard text 
are	noted	(with	a	line	to	the	left	of	the	text),	
even	if	Track	Changes	option	was	turned	off	
during	editing.

QUICK TIP 5

Document A101™ – 2017 
Standard Form of Agreement Between Owner and Contractor where the basis of 
payment is a Stipulated Sum 

This document has important 
legal consequences. 
Consultation with an attorney is 
encouraged with respect to its 
completion or modification. 

The parties should complete 
A101™–2017, Exhibit A, 
Insurance and Bonds, 
contemporaneously with this 
Agreement.

AIA Document A201™–2017, 
General Conditions of the 
Contract for Construction, is 
adopted in this document by 
reference. Do not use with other 
general conditions unless this 
document is modified. 

AGREEMENT made as of the day of
in the year
(In words, indicate day, month and year.) 

BETWEEN the Owner: 
(Name, legal status, address, and other information) 

     
   
   
   

and the Contractor: 
(Name, legal status, address, and other information) 

     
   
   
   

Cynthia Cortes
1735 New York Avenue, NW
Washington, DC
20006

Best Construction Company
9300 Corporate Blvd.
Rockville, MD
20850
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Creating contacts from a document for a new project

Follow	these	steps	when	you	want	to	create	a	new	project	and	its	associated	
contacts	and	team	members	while	creating	a	form	or	document.

• Select	a	template	on	the	Template	Library	tab.	The	Online	Editor	or	Form	Editor	opens,
depending	on	the	document	type.

• Enter the project	and	contact	information	in	the	spaces	provided	in	the	form	or	agreement.

• Select Save or Save As.

• Click	the New	Project	button	in	the	Save	Document	As	dialog.

• Verify the project	name	as	it	appears	in	the	Project	Name	text	box	and	click	the Save
Project	link.	The	project	is	created	and	the	contacts	are	added	to	your	contacts	and	to	the
project	team	members	listing.

• Click	OK	to	return	to	your	document	in	the	editing	window.

Adding contacts to a project team
• Open	the	project	and	click the Edit	Project	Data	button	in	the	Project	Details	window	to
enable	changes.

• On	the	Project	Team	tab,	click the Add Team Member	button.	The	Add	to	Project	Team
dialog	appears,	allowing	you	to	add	team	members	from	your	contacts.

• Select	the	check	boxes for one or more of your contacts and click	OK to add them to the
Project	Team	list.

• Click	Create	Contact	button	from	the	Add	to	Project	Team	dialog	to	create	a	contact	from
scratch	and	save	it	to	your	global	contacts.

Removing contacts from a project team
• Open	the	project and click the Edit	Project	Data	button	in	the	Project	Details	window	to
enable	changes.

• On	the	Project	Team	tab,	select	the	check	boxes for one or more team members and click
the Remove Team Member	button.	The	selected	team	members	are	removed	from	the
Project	Team	list.

Editing a contact
• On the Contacts tab, locate the desired contact and click	Edit	Contact.	The	Create
Contact	dialog	opens,	displaying	the	contact’s	existing	details.

• Make	your	changes	to	the	contact	information	as	needed.

• Click	OK to save the contact changes and close the dialog, or click	Cancel to close the
dialog	without	saving	changes.

Deleting a contact
• On the Contacts tab, locate the desired contact and click	Delete	Contact.	A	warning
message	is	displayed	that	states	“Are	you	sure	you	want	to	delete	the	contact
“[contact_name]”?”

• Click the OK	button	to	confirm	the	deletion,	or	click	Cancel	to	exit	without	deleting.
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Sharing a document for review
You	may	need	to	share	a	draft	document	or	form	with	your	clients	and	colleagues	
to	get	their	feedback	before	generating	the	final	version.	AIA	Contract	Documents	
provides	the	ability	to	share	draft	documents	with	other	parties	for	online	
collaborative	editing.

Working	draft	documents	(all	A,	B,	and	C	series	documents,	as	well	as	G601	and	
G602)	are	generated	with	Track	Changes	turned	on	by	default	and	each	reviewer’s	
changes	are	indicated	by	a	different	color.	

You can share a document with collaborators in either of two ways:
• From	the	Project	Details	click the More Actions	link	for	the	document	and	select Share for
Review	from	the	popup	menu.

• From	within	the	document	in	the	editing	window	click the Share for Review button on the
sidebar.	The	Share	for	Review	dialog	opens.

• Verify	the	subject	and	message	body	and	make	any	changes	needed.

• Use the Select from Distribution List and Select From	Contacts	links	to	select	recipients
from	your	project	team	and	contacts.	You	can	also	type	email	addresses	for	other
recipients.

• Select the Review	Expiration	Date	using	the	date	picker	to	specify	a	completion	date	for
the	review.

• Click	OK	when	finished.

An	email	will	be	sent	to	each	reviewer	containing	a	unique	encrypted	link	that	they	
may	use	to	access	the	online	document	to	perform	their	reviews.	

AIA’s	online	editor	offers	users	online	track	changes.	As	the	online	track	changes	
functionality	extends	one	level	only,	please	note	the	following	when	using	the	“Share	
for	Review”	feature:

• If	the	Author	has	enabled	track	changes	to	track	her	edits,	the	system	provides	the	invited
reviewer	a	copy	where	all	the	edits	noted	in	the	track	changes	have	been	accepted.

• Each	Share	for	Review	invitation	as	appended	with	a	PDF	formatted	variance	checked
copy	of	the	Author’s	draft.

If	the	Author	has	invited	multiple	reviewers	
to review the document, and where there 
are	edits	by	multiple	reviewers	on	the	same	
text	in	the	Author’s	document,	the	system	
will	only	show	the	last	reviewer’s	edits.

The reviewer receives the emailed invitation 
and	begins	the	review	process	as	follows:
• Clicking the encrypted	link	provided	in	the

e-mail

Only one reviewer can access the shared 
file	at	a	time.	Clicking	Check In or Done 
makes	the	document	available	to	other	
reviewers.	Reviewers	may	not	reopen	the	
document	after	clicking	Done.

QUICK TIP 6



Beginner’s Guide for AIA Contract Documents Online Service for Multi-Users 20

• Reviewing and	accepting	the	terms of use to access the document

• Reviewing and editing the document

• Clicking	Save to save changes

• Clicking	Check	In	to	save	changes	and	make	the	document	available	to	other	reviewers

• Clicking	Done	when	the	review	is	complete

When	a	document	is	shared	for	review,	it	is	listed	in	your	project	documents	with	
a status of In Collaboration.	Clicking	the	link	displays	the	Review	Status	dialog,	
showing the name of the document, the review start and end dates, the e-mail 
addresses of the reviewers, the status of their reviews, and their most recent activity 
date.	When	collaboration	is	ended	the	status	will	appear	as	Review Complete.

Creating a project manual
AIA	Contract	Documents	provides	you	with	the	ability	to	combine	final	documents	
and	other	PDF	files	into	a	single	project	manual	in	PDF	format.	

To create a new project manual for a project: 
• In	the	Project	Details	area,	click	the	Project	Manual	button.

• Locate	the	project	in	the	projects	list	and	click								the	icon	to	expand	it	so	the	project	
documents	are	shown.

• Select the check	box	beside	the	documents	to	be	included	in	the	project	manual.	As	you
select	the	documents,	they	are	added	to	the	Selected	Documents	list.	You	can	use	the
small	arrow	buttons	to	move	documents	up	or	down	to	arrange	them	in	the	order	in
which	you	want	them	to	appear	in	the	project	manual.

• When	you	finish	selecting	documents,	type	the	name	of	the	project	manual	in	the	“Save
Project	Manual	As”	text	box	and	click	OK.

• A	message	is	displayed	that	the	project	manual	was	generated.	The	document	will	appear
in	the	list	of	your	project	documents.

Digital signatures
AIA	Contract	Documents	allows	you	to	sign	final	documents	digitally.	If	you	have	
enabled	the	digital	signature	option,	a	new	digital	signature	placeholder	page	is	inserted	
in	your	final	document	immediately	after	the	written	signature	block	and	the	notation	
“see	attached	digital	signatures	page”	is	inserted	in	the	written	signature	block.

Refer to http://www.aia.org/contractdocs/AIAS077674 for	more	information.

+

http://www.aia.org/contractdocs/AIAS077674


Beginner’s Guide for AIA Contract Documents Online Service for Multi-Users 21

Learn more
The	AIA	Contract	Documents	Learn	page	is	a	comprehensive,	user-friendly	website	
that	offers	design	and	construction	professionals	high-quality	Contract	Documents-
related	education	programs	and	materials.	Users	of	the	site	can	access	live	training	
webinars,	on-demand	courses,	and	an	extensive	library	of	written	resources.	Most	
courses are eligible for continuing education credit from the AIA, as well as other 
professional	organizations.	Visit	aiacontracts.org/learn	

To attend a free, online AIA Contract Documents Online Service Basics webinar click	
here	and	select	an	available	date	from	the	drop-down	menu.	

Product support
All	AIA	Contract	Documents	Support	Lines	are	open	Monday–Friday,	
from	8:30	a.m.	to	6:00	p.m.	Eastern	time.

Technical support 
Telephone:	(800)	942-7732 
Fax:	(202)	879-3083 
Email:	docstechsupport@aia.org

Content support 
Telephone:	(202)	626-7526 
Email:	docinfo@aia.org 

Education contact for inquiries 
Telephone:	(202)	626-7592 
Email:	aiadocsed@aia.org

https://www.aiacontracts.org/learn
https://register.gotowebinar.com/rt/766049916144892164
https://register.gotowebinar.com/rt/766049916144892164



